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Introduction to Spreadsheets
Spreadsheet programs are widely used for business, academic and personal purposes.  One of their key benefits is that they allow easy manipulation of data and graphing.  They also allow you to perform “what-if” analyses and simple statistical calculations.  These instructions refer specifically to Excel, but other spreadsheet programs (e.g., Quattro Pro or Lotus) operate in a similar manner.  Once you learn how to use one program, it is easy to learn how to use others.  The instructions below are written specifically for Microsoft Excel 2002 on a Windows computer, but other versions of Excel should work in the same way.  

Note: In this handout, “clicking” refers to a click of the left mouse button.

Opening Excel
You must have Microsoft Excel installed on your computer to do the exercises required for these labs.  If there is a Microsoft Excel icon on the computer after it starts, you can open Excel by double clicking on it.  Otherwise, you will find Excel on the “Start” menu under “Programs” or “All Programs”.  (Click on the Start button on the bottom left of your screen to pull up this menu.)

Once Excel is open, one feature you should note right away is the “toolbar” underneath the menu at the top of the screen.  As you move your cursor over the toolbar, if you pause on any one button, a short explanation of what that button does appears.  Note the button with the question mark on the far right of the toolbar.  Clicking on this button will provide you with online help.  Functions that are not available on the toolbar are available from the pull-down menus at the top.  As you move your cursor over these menus you can see what additional functions are available.

	· Look for the command to adjust column width.  Which menu is it under?


To open a file, click on the yellow opening folder on the toolbar.  You may find it helpful to download a file from the first lab and open it so you can practice some of the operations described below as you read through this handout.  To open a spreadsheet file, click on it to highlight the file name and then click on the Open button on the right of the dialog box.

	· Download the Excel data file for these labs and save it to your computer.  Open it in Excel.


Data Manipulation
You will use a number different types of data manipulation for these labs.  Instructions for each operation are below.  So that Excel knows you are typing a formula and not typing text, you must precede all formulas with an “=” sign.

Adding

· To add two numbers in the spreadsheet together, click on an empty cell.  Type an = sign and then click on the cell that contains one of the numbers you would like to add.  Type a + sign and then click on the cell that contains the second number.  Hit Enter.  

One of the really useful things about spreadsheets is that once you have a formula entered, you can change the numbers that the formula uses and your answer is updated.  Try doing this by changing one of the two numbers you added together.  We won’t be using this feature much in this course, but you can imagine if you are trying to test the sensitivity of your calculations to various assumptions you have made, this feature is quite useful.  

· You can add two columns together by copying the formula for adding two numbers into a third column:

1. 
Click on the cell in which you would like to start the column that contains the sum of the two columns.  If you need to make space in your worksheet for this column you can insert an empty column in your worksheet by choosing Column under the Insert Menu.  Once you are in the first row of the column in which you would like the answer to appear, add the first two numbers in each column as described above.

2. 
Click on the cell that contains the answer from step 1.  

3. 
Click on the copy toolbar button (it has two pieces of paper on it and is usually next to the scissors).

4. 
Drag your mouse over the range to which you would like to copy the formula.  (Dragging the mouse means holding down the left mouse button and moving the cursor over the range you want to highlight.)

5. 
Hit Enter.

	· Insert a column after Real GDP per capita in 1960.  Place in this column the sum of Real GDP per capita in 1960 and in 2000.




· 
To sum all the numbers in a column (or a row) place your cursor where you would like the answer to appear and type:
=SUM(


Then drag your mouse over the range of numbers you would like to add.  Hit Enter.  

· 
An alternative procedure for adding in Excel is to use the ∑ button on the tool bar.  To use this feature, click on the ∑ and then highlight the row or column that contains the numbers you would like to add.  Hit Enter.

	· Calculate the sum of the numbers in the Real GDP per capita 2000 column.




Subtracting, Multiplying & Dividing
You can subtract, multiply or divide two numbers or two columns by using the instructions for adding and substituting in a -, *, or a /.

Complex Formulas
You can enter fairly complex formulas in Excel by combining any of the functions.  Just be careful to enter the parentheses correctly.  For example, =(A1 + A2)/A2 will not give you the same answer as =A1 + (A2/A2).  If you make a mistake and don’t have the same number of left parentheses as right parentheses, Excel will not perform the calculation.

	· Subtract Real GDP per capita in 2000 from Real GDP per capita in 1960 and divide this answer by 40 to get the change in income per year over this 40 year time period.




Calculating an Average and Using Other Functions

You can calculate an average of a column or a row by using the Average function.  Simply type:

=AVERAGE(

Then drag your mouse over the range of numbers for which you would like to find the average.  Hit Enter.

There are several functions that Excel provides that work like the SUM and the AVERAGE function.  To see all that are available to you, click on the equals sign that appears right below the toolbars in the upper left portion of the screen and a list of functions will appear on the menu to the left.

	· Use an Excel function to find how rich the richest country was in 2000.




Formatting Your Spreadsheet
Some numbers you may want to display in your spreadsheet as dollars, others as a percent, and others with commas in the appropriate places.  The default display does not provide any formatting.  To change the formatting of a range of numbers, highlight that range by dragging your mouse over it and then clicking on the appropriate formatting button on the toolbar.  The dollar sign changes everything to a currency format, the percent sign changes everything to a percent format, and the comma button will put commas in the numbers.  You can change the number of decimals displayed by clicking on either the increase decimal button or the decrease decimal button (the two buttons with a bunch of zeros on them).

	· Change the format of Real GDP per capita in 2000 variable to a currency format.




Sorting Data
In addition to performing calculations, spreadsheets allow you to sort your data either alphabetically or numerically.  To sort the data, 

1. 
Highlight all of the data you would like to sort.  

2. 
Under the Data menu, choose Sort.  

3. 
Select the column you want to sort the data by in the “Sort By” field.  You can choose ascending sort (smaller to bigger) or a descending sort (bigger to smaller).  You can also put in secondary sorting criteria by typing something in the “And Then” fields.  For example, if you had a list that you wanted to sort first by last name and then by first name, you would enter the column that contained last names in the “Sort By” field and the column containing the first names in the “Then By” field.  If you leave the “Then By” field blank, Excel will perform the sort without a secondary key.  

4. 
Click on the OK button and Excel will perform the sort.

When sorting data, it is extremely important that you highlight all of the data that goes together.  Otherwise, Excel will only sort a subset of your data.  For example, suppose you have a spreadsheet with a column containing a person’s name and a column containing a person’s grade in a class.  If you sort by name and don’t include the grade column in your data range, Excel will only sort the name column and not the grade column.  The result would be a spreadsheet with names in alphabetical order, but the grades next to the names would not be the correct ones.

	· Sort the data by the Real GDP per capita in 1960 column.  Which country was the richest in 1960?




Printing a Spreadsheet
You can print the entire spreadsheet by clicking on the button in the toolbar that has the printer on it.  If you would like to print only a portion of your spreadsheet, highlight the portion you would like to print by dragging your mouse over it.  Then, under the File menu, choose Print.  A dialog box will appear.  In the lower left corner, click on Selection.  Click on OK.

	· Print the country name column.




Graphing
You can make several types of graphs in Excel.  The instructions below tell you how to make a scatterplot, but once you know how to make one kind of graph in Excel, it is easy to make others.

Making A Scatter Plot
A scatter plot is a graph on the xy plane that does not connect any of the data points.  To make one in Excel, you must have two data series.

1. 
Select the data you want to use in the chart.  If the two series are in adjacent columns or rows in the spreadsheet, you can select them by dragging your mouse over them and highlighting them.  If the two series are not in adjacent rows or columns, select the first one by dragging your mouse over it and highlighting it.  Then press the control key (the key labeled Ctrl, usually found on the bottom row of your keyboard) and drag your mouse over the second series.

2. 
Click on the toolbar button that has the 3-D bar chart on it.  (The Chart Wizard)

3. 
Click on  XY (Scatter plot) for the Chart type.  Choose the chart subtype that looks like the scatter plot (a bunch of points not connected with a line) and click on the Next button.

4. 
In the data range box you can check and make sure that Excel is getting the data from the correct part of the spreadsheet.  If your data is in rows and Excel thinks it is in columns you can tell Excel your data is in rows by clicking on the Rows option.  Likewise, if your data is in columns and Excel thinks it is in rows, select the Columns option.  Click Next if the data range is correct.

5. 
In this step you can add titles and axis labels to your graph.  Type in what you would like to appear on the graph in the boxes provided.  Click on the next button.

6. 
Finally, Excel gives you a choice to either create the chart in a separate file or place the file in the spreadsheet you have open.  For this class, it may be easier for you to create each chart as a separate file to help you organize the work you are handing in.  Either choice, however, will let you print the graph.  Make a choice here and click on Finish.

7. 
The chart will appear on your screen.  You can edit various aspects of the graph by clicking on them with your mouse and setting the options.  By default, Excel will put a legend on the right side of the page that says Series 1.  This type of legend is not appropriate for a scatter plot.  Click on the legend to select it and hit delete.  

8. 
To print the graph, click on the button in the toolbar that has a picture of a printer on it.

9. 
If you have opted to put the graph in a separate file, you can return to the data in the original spreadsheet by clicking on the tabs at the bottom of the file.  If you make changes to the data in your spreadsheet, the graph will change.

	· Make a scatter plot of Real GDP per capita in 1960 vs. Real GDP per capita in 2000, carefully labeling the axes.




Exiting Excel

Be sure to save your work (click on the image of the floppy disk in the tool bar) before exiting Excel.





